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Zdravo svete!

The 5th Wave By Rich Tennant
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Bad lepo §fo ftvoj radunar ima 256 boja, dli
ne mora$ ba$ sve da ih upotrebi§ u jednom sastava.”
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U ovom delu...

“ davna, pradavna vremena, nasi preci Og i Gronk
sedeli su i mastali o danu kada ¢e moci da sebi pri-
uSte dobar racunar, sa efikasnim programom za obradu
teksta na kome ce iskazati svoje misli. Avaj, u to vreme
ne beSe niceg sem kamenja. I tako, Og poce pazljivo

da urezuje kamenom svoje misli u zid pecine, ali Gronk
ispusti jedan zadivljujuci preistorijski podrig i pecina
se srusi.

Ne odustajte tek tako od pokuSaja da savladate program
za obradu teksta! Naravno, presli smo dug put od crtanja
po pedinskim zidovima. Drevni Egip¢ani podarili su nam
papir. Feni€ani su izmislili alfabet. Gutemberg je razvio
pokretni slog. Pisa¢a maSina je omogucila nama sa
ocCajno ruznim rukopisom da uveZbavamo umetnost
pisanja a da pri tom Citaoci ne postanu zrikavi.

Sada imamo i program za obradu teksta. Toliko smo se
navikli na njega da zaboravljamo na egipatski papirus,
na Gutemberga i stare pisace masine. Reci se kao cudom
pojavljuju i mozemo ih izbrisati, premestiti, pretraZivati,
snimati i Stampati — sve to sa samo nekoliko poteza iz
rucnog zgloba. Ne dozvolite da preistorijski Gronk stane
na put vasim Zeljama da proucite ovaj program. Opu-
stite se i uZivajte u ovih nekoliko poglavlja koja govore
o samom pocetku vaSe odiseje po svetu obrade teksta.
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Poglavije 1

Pogled izbliza

U ovom poglaviju
Pokretanje Worda
Citanje Wordovog ekrana
Dobijanje pomo¢i od Worda
Koriscenje tastature
Izlazak iz Worda (da ili ne)

Bilo je to najbolje doba, bilo je to najgore doba.

Z ar ne sanja svako o tome kako c¢e jednog dana postati slavan pisac?
Ili kako ¢e dobiti Oskara za scenario za film? Tu je i manje primam-
ljivo pisanje izveStaja, memoranduma, zapisivanje poruka ili liste svako-
dnevnih poslova. Sve su to reci. Od prvih slova napisanih kod uciteljice,
do prvog pasusa u najvecem americkom romanu ovog veka — sve to su
samo reci.

Mozda to beSe najprosecnije doba?

Najbolji softver koji radi s reCima, obi¢nim ili proroCanskim, jeste pro-
gram za obradu teksta poput Microsoftovog Worda.

1li da ipak ostavimo istoriji da uobli¢i doba. Imam kreditnu Rarticu i,
tako mi svega, Roristicu je!

Ovo poglavlje vas uvodi u Microsoft Word. Daje vam osnove pomocu
kojih cete razumeti kako se Word uklapa u vas racunarski svet. Osim
toga, mozda ¢e vam doneti nekoliko iznenadenja. Zato bolje krenite
na ovaj zabavan put ka pisanju svega Sto vas um moZe da smisli.
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70 Deo I: Zdravo svete!

Dobar,

najbolji i najgori nacin

da pokrenete Word

%@]ET

liise?!

Kako da te pokrenem, Worde? Da vidim kako sve mogu...

Svako ko radi na raCunaru pretpostavlja da verovatno postoji bolji, brzi ili
ozbiljniji nacin da se nesto uradi. A nacina je zaista mnogo. Ko zna kada ce
neko iskociti ispred vas i nasmejati se nacinu na koji pokrecete program

za obradu teksta. ,,Ti to tako radis?“, zabezeknuce se. | Sta onda?

Ne dajte da vas preplase! RaCunar se moZe pokrenuti na viSe naCina nego
Sto pijani majmuni mogu da demoliraju prodavnicu antikviteta. Sigurno
je jedino da ne treba gubiti vreme na objasnjavanje svega. Zato ¢u vam
objasniti samo uobicajene, bolje i najbolje nacine da pokrenete Word.
(One najgore moZzete naci u nekoj drugoj knjizi drugog autora.)

Na pocetku, evo osnovnih koraka da biste bilo Sta uradili:
1. Neka racunar bude ukljucen i zagrejan.
Svaki raCunar koji je ukljucen je, zapravo, i zagrejan. Jedini nacin
da ga zagrejete jos viSe jeste da ga stavite na Stednjak, Sto svakako
ne preporucujem.
2. Pripremite se fizicki.
Obavezno sednite uspravno. Kazu mi da zglobovi treba da budu u

ravni s ramenima, a da Celo ne treba naginjati napred. Ramena treba
da budu opustena.

Da li su vam prsti spremni da zaigraju na tastaturi? Dobro!
3. Pripremite se psihicki.
Zatvorite oci. Opustite se. [zdahnite. Zamislite mirnu, plavu vodu.

Pripremite se da vam misli odlete u raCunar. Zapamtite, vi ste gospo-
dar. U sebi neprestano ponavljajte: Ja sam gospodar...

U knjizi PC za neupucene, takode u izdanju Mikro knjige, potraZite vise
podataka o tome kako da pokrenete racunar.

Sad mozZete da prestanete da mrmljate ,ja sam gospodar*.

Nemastovit nacin da se pokrene Word

Svaki program pod Windowsom bez greSke cete pokrenuti pomocu
Ccuvenog dugmeta Start. To moZda nije kul nacin da se pokrene program,
ali je pouzdan - Sto za racunar mnogo znaci. Obratite paznju:

1. Pritisnite dugme Start.

MiSem pritisnite dugme Start koje se obi¢no nalazi u levom uglu
palete poslova, pri dnu ekrana.

Pritiskanje dugmeta Start otvara istoimeni meni.
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Poglavlje 1: Pogled izbliza

2. Izaberite All Programs > Microsoft Word, mada moZete da priti-
snete i All Programs => Microsoft Office => Microsoft Office Word
2003.

Meni koji se pojavljuje zove se ,Programs* ili ,,All Programs*.
Pogledajte sliku 1-1. Ime programa moZze da bude samo Word ili
Microsoft Word ili moZda Microsoft Word 2003.
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Gledajte zacudeno u racunar koji zuji i bruji. Kroz nekoliko trenutaka na
ekranu se pojavljuje Word, koji pokuSava da bude ljubazan, gostoljubiv
i zabavan kao pilotska kabina borbenog aviona.

Ne dajte da vas Word zaplasi! O tome Sta je na ekranu bice reci kasnije
u ovom poglavlju, u odeljku ,Word na ekranu®.

Automatsko otvaranje Worda pri svakom
pokretanju Windowsa

Da bi racunar otvorio Word kad god pokre-
nete Windows, u meniju All Programs meni-
ja Start pronadite stavku Microsoft Word.
Misem prevucite tu stavku u podmeni Start-
up, koji se automatski otvara da bi prihvatio
Word kao novu stavku. Na taj na¢in se Wor-
dov meni prebacuje u direktorijum Startup,
odakle ¢e se automatski pokretati svaki put
kad pokrenete Windows.

Ukoliko pogresite, pritisnite Ctrl+Z (kombi-
nacija za ponistavanje operacije) i pokusajte
ponovo.

Ako mislite da ovaj manevar prevazilazi vase

sposobnosti, zamolite nekog racunarskog
sveznalicu da uradi to umesto vas.
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’2 Deo I: Zdravo svete!

Moj omiljeni nacin za pokretanje Worda

E Ja najvise volim da pokrenem Word tako Sto ga otvorim preko precice
postavljene na radnoj povrsini (engl. desktop) ili pritisnem dugme na
paleti Quick Launch. Oba nacina su direktnija od bezveznog menija Start,
a put preko palete Quick Launch je najbrZi zato §to je za otvaranje pro-
grama dovoljno da samo jednom pritisnete odgovarajuce dugme.

Bez obzira na to da li precicu za Word postavljate na radnoj povrSini ili
na paleti Quick Launch, prvi korak uvek podrazumeva da napravite pre-
Cicu. Ovo je mozda malo zamrSeno pa se zato maksimalno koncentrisSite
i uradite sledece:

1. U meniju Start pronadite stavku Microsoft Word.

Ne pokrecite Word! Samo postavite pokaziva¢ misa na tu stavku, kao
Sto se vidi na slici 1-1.

2. Pritisnite stavku desnim tasterom misa.
Pojavljuje se priru¢ni meni.
3. Iz menija izaberite opciju Send To > Desktop (create shortcut).

[ to je to. Upravo ste iz menija Start kopirali stavku Word. Nista
lakSe! Da biste proverili:

4. Pritisnite miSem bilo gde na radnoj povrsini.

Radna povrSina je pozadina koju vidite dok radite u Windowsu. Ako
pritisnete bilo gde na povrSini, sakricete meni Start.

5. Pronadite ikonicu precice Microsoft Word.
Izgleda kao sli¢ica na margini na pocetku ovog odeljka: plavo slovo

W u kvadratu ispod kojeg piSe Microsoft Word. To je vasa precica
za Word.

Sada moZete da pritisnete ikonicu precice i tako pokrenete Word umesto
da se petljate s menijem Start.

Ako vam se visSe dopada da Word smestite na paletu Quick Launch, pre-
vucite ikonicu do palete: odvucite pomoc¢u misa ikonicu Worda do palete
Quick Launch, a zatim pustite taster miSa i ikonica c¢e ,pasti“ na paletu,
Sto se vidi na slici 1-2. (MoZda cete morati da proSirite paletu Quick
Launch da biste videli ikonicu Worda; detaljnije informacije o paleti
Quick Launch naci c¢ete u knjizi PC for Dummies.) Sada je dovoljan samo
jedan pritisak na taster misa i Word ce se pretvoriti u moc¢an program
za obradu teksta.
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Poglavlje 1: Pogled izbliza

Slika 1-2:
Smestanje
Worda na

paletu Quick
Launch.
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Ovde prevucite ikonicu Worda

Pokretanje Worda otvaranjem dokumenta

Word se koristi za izradu dokumenata. Oni su sli¢ni dokumentima na
papiru, samo Sto se zovu datoteke (engl. files). Datoteke se na ekranu
pojavljuju kao slicice. Kad god uocite sli¢icu Wordovog dokumenta,
moZete je dvaput pritisnuti miSem da biste pokrenuli Word i otvorili
taj dokument. Evo kako to moZe da se izvede:

1. Otvorite direktorijum My Documents.
Kao i drugi programi, Word smesSta ono Sto napravite u direktorijum
My Documents. Ovaj direktorijum moZete naci na radnoj povrsini ili
u meniju Start: postavite miSa na taj direktorijum i pritisnite ga dva-
put da biste ga otvorili.
2. Pronadite Wordov dokument.
Wordov dokument se pojavljuje u obliku ikonice dokumenta s pla-
vim slovom W, kao Sto se vidi na margini na poCetku ovog odeljka.
3. Pritisnite dvaput ikonicu Wordovog dokumenta.
Time pokrecete Word i otvarate dokument da biste ga uredili, proci-

tali, izmenili, proucili, iskasapili ili upropastili do neprepoznatljivosti.

Ovako moZzete otvoriti sve Wordove dokumente. Dokument moZe biti na
radnoj povrsini, u direktorijumu My Documents ili u ma kom drugom
direktorijumu ili na bilo kom drugom mestu gde se Wordov dokument
moZe sakriti.

v Ime dokumenta pojavljuje se ispod ikonice. Na osnovu imena mozete
utvrditi sadrZaj dokumenta — ukoliko je dokument snimljen na disk
pod odgovarajuc¢im imenom. ViSe o tome kasnije.

v Ako Cesto otvarate samo jedan dokument, bilo bi dobro da na rad-
noj povrsini napravite precicu za njega, tako da moZete brzo da mu
pristupite: desnim tasterom miSa pritisnite ikonicu dokumenta i
izaberite Send To = Desktop (create shortcut).
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’4 Deo I: Zdravo svete!

QPNEI

v U meniju My Recent Documents, koji birate iz menija Start, mozete
videti listu poslednjih dokumenata na kojima ste radili: pritisnite
dugme Start, a zatim potraZite listu My Recent Documents. (U nekim
verzijama Windowsa stoji samo Document.) Sa liste izaberite doku-
ment Kkoji ¢ete otvoriti.

v Pojedini Wordovi dokumenti pojavice se sa oznakom .doc na kraju
imena. To je nastavak imena datoteke (engl. filename extension), a
njegovo prikazivanje je opciono. Prikazivanje nastavka imena dato-
teke zavisi od toga kako ste podesili Windows.

Word na ekranu

=

Cim pokrenem Word, prelazim na maksimalnu opciju. To ne znaci da
poruc¢im maksimalno velike pice. Ne, maksimiranje je Windowsov trik
za povecavanje povrsine ekrana koju Word zauzima.

Da bi se Wordov prozor otvorio preko celog ekrana, pritisnite dugme za
maksimiranje (srednje od tri dugmeta) u gornjem desnom uglu prozora.
Dugme poveca prozor Worda tako da ispuni ceo ekran. Ako je prozor veé
maksimiran, na dugmetu se vide dva kvadratica, jedan preko drugog; u
tom slucaju ne morate niSta da menjate.

Posto se Word rasprostro po ekranu, procitajte ovo sto sledi i pogledajte
sliku 1-3 da biste pronasli mnoge nove i uzbudljive stavke na tipicnom
praznom Wordovom ekranu.

Stvaréice i napravice

Wordov primaran posao je da vam pomogne pri pisanju. Pa, nije to bas
pisanje u stilu Carlsa Dikensa ili DZejn Ostin. Zapravo, ono 5to Word
najbolje radi jeste obrada teksta. Zbog toga je i najvec¢i deo Wordovog
ekrana namenjen sastavljanju teksta (slika 1-3).

Prostor za pisanje okruZen je raznim drangulijama, dugmadima i drugim
tricarijama koje bi bile zanimljive samo da su jestive. Dobro je to Sto sve
te stvarcCice u Wordu moZete da prilagodite svojim potrebama (bolje bi
vam bilo da znate Sta sve to znaci pre nego Sto krenete da menjate):

v Naslovna traka (engl. title bar), na kojoj piSe Document1, sve dok
dokumentu ne date ime kada ga sacuvate na disku.

v Traka s menijima (engl. menu bar) sadrzi punu listu raznih Wor-
dovih komandi.

v Paleta standardnih alatki (engl. Standard toolbar) i paleta alatki za
formatiranje (engl. Formatting toolbar), prikazane su jedna pored
druge na slici 1-3, iako moZete da ih razmestite onako kako vama
odgovara.
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Poglavlje 1: Pogled izbliza

v Lenjir (engl. ruler) pomaZe da postavite margine i tabulatore.

v Okno za poslove ili namenski prozor (engl. task pane), s listom
komandi ili opcija neophodnih za ono sto trenutno radite u Wordu.

— Vertikalna klizna traka
Horizontalna klizna traka — Dugme za zatvaranje programa

Dugme za maksimiranje

Paleta alatki za formatiranje Lenjir Polje za pitanja
Paleta Dugme za
standardnih alatki  Naslovna traka Traka s menijima minimizovanje
T ettt el | B TF
Fis Bl Wes iman Fomal Jesks Taels Wides |iisis L s lml
R R - L e R S R BT ] |
— iy P T o — s R = l= S RN X A .-nd;.*
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Slika 1-3: i
Prozor s BT
programa L o : !
Word. o a ] M| J
—— Pl T n_ o Er. w1 el d |
I I1 I ]
Statusna traka Podaci o poloZaju kursora | Dugmad za pronalazenje Okno za poslove
Dugmad za prikaze Prazan prostor za pisanje  Dugme za zatvaranje dokumenta

Ispod prostora za pisanje nalaze se dva elementa:

v Dugmad za prikaze (engl. view buttons) postavljena su levo od hori-
zontalne klizne trake i kontroliSu nacin prikazivanja dokumenta.

v Statusna traka (engl. status bar) sa dosta nevaznih podataka o vasSem
dokumentu od kojih su neki i zanimljivi.

Sta svako od dugmadi, traka i menija ¢ini i da li je vazno ili nije, procita-

cete na nekom drugom mestu u knjizi. Za sada je samo bitno da znate
njihova imena, kako se kasnije ne biste izgubili:
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v Vedinu ovih stvarCica mozete podesiti prema sopstvenim potre-
bama. Ne samo da moZete menjati i premeStati Wordove opcije
onako kako vam odgovara, nego vecinu njih moZete skloniti sa
ekrana tako da vam ostane samo prazan prostor za pisanje.

v Vedina korisnika uglavnom nisSta ne menja. Avaj.

v Statusna traka nije kolovozna traka za skupe automobile. Ona
sadrzi podatke, Cesto tajanstvene, o dokumentu u kome radite.
U knjizi je objasnjeno kada ove informacije mogu da vam budu
korisne.

v Naslici 1-3 dat je Wordov prikaz Print Layout. Ukoliko prikaz na
vaSem ekranu izgleda drugacije, izaberite View = Print Layout.
(Neki vise vole da koriste prikaz Normal.)

v Da bi se palete Standard i Formatting pojavile u zasebnim redovima,
pritisnite na jednoj od njih strelicu usmerenu nadole. Pojavljuje se
padajuci meni u kome birate opciju Show Buttons on Two Rows.

v’ Okno za poslove se verovatno nece pojaviti dok vam ne zatreba
ili dok ne upotrebite odgovarajuc¢e Wordove komande. Izaberite
View => Task Pane da biste prikazali ili sakrili okno za poslove.

v Windowsova paleta poslova (engl. taskbar) na dnu ekrana, deo je
Windowsa a ne Worda. Medutim, kada u Wordu otvorite dokume-
nte, na paleti se pojavljuje odgovarajuce dugme za svaki otvoreni
dokument.

v Da li ste primetili kako izgleda pokaziva¢ miSa na slici 1-3? To je
pokaziva¢ mesta umetanja (engl. insertion pointer) koji li¢i na veliko
slovo 1. Tako izgleda pokaziva¢ miSa kad njime prelazite preko
Wordovog dokumenta. Veliko slovo I je, u stvari, poCetak reCenice:
»1 bas ovde treba da se ubacim kad pritisnete taster misa.“

v Linije pored (ili ispod) pokazivaca mesta umetanja deo su Wordove
osobine ,izaberi i pisi“ o kojoj ¢emo govoriti u poglavlju 18, u odeljku
u kome se razmatra automatsko formatiranje.

v MiS moZete upotrebiti da biste saznali Sta u Wordu radi ona silna
dugmad i sitnurija sa sliCicama. Postavite pokazivac iznad dugmeta

i voila! — istog trenutka se iskristali§e informacija.
v Ukoliko ne vidite lenjir ili palete Standard i Formatting, ili Zelite da

promenite izgled Wordovog ekrana upravo sada, skoknite do
poglavlja 28.

Prazan prostor na kome pisete

Kada pokrenete Word, suocCavate se sa elektronskom verzijom praznog
papira koji generacijama pisaca oduzima inspiraciju ¢im ga ugledaju.
Covek ne moZe da se ne zapita jesu li egipatski pisari ikada gubili inspi-
raciju pri pogledu na papirus.
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Poglavlje 1: Pogled izbliza

Kljuc pisanja u Wordu je da u tekstu pronadete mesto umetanja - trepcuci
kursor, koji vam pokazuje gde ¢e se pojaviti ono §to kucate:

Izaberite View = Normal.

U prikazu Normal veci deo ekrana namenjen je pisanju teksta. Ravna,
horizontalna linija na kraju teksta, odmah ispod trepcuceg kursora, jeste
oznaka Rraja teksta (engl. end of text marker). Oznaka kraja teksta je
Celicna greda koja podrZava tekst, Cuvajuci ga od zlih sila iz praznog
prostora ispod njega:

Izaberite View = Print Layout.

U prikazu Print Layout nestaje oznaka kraja teksta. Za razliku od prikaza
Normal, ovde je bitno kako tekst izgleda na strani. Ja viSe volim da piSem
u prikazu Normal, pa da onda predem u prikaz Print Layout da bih for-
matirao i uredio tekst.

v O pisanju (ili kucanju, u zavisnosti od toga koliko ste dobri) govo-
ricemo u sledecem poglavlju, tj. poglavlju 2.

v Svaki uvrnut znak koji vidite na ekranu (na primer, {) predstavlja
Wordov tajni simbol. U poglavlju 2 saznacete zaSto biste uopste Zeleli
da vidite ove tajne simbole i kako da ih sakrijete ako vas nerviraju.

v Kursor pokazuje tacno mesto na kome se tekst pojavljuje. Cesto ga
zovu i pokazivaCem mesta umetanja, zato Sto su klasic¢ni kursori
podvlake koje se pojavljuju ispod teksta dok kucate. Meni se vise
dopada termin kursor jer, za moj ukus, izraz pokaziva€ mesta ume-
tanja previSe podseca na geometriju. Znaci koje kucate pojavljuju
se naposredno levo od mesta na kome treperi kursor, zatim se kur-
sor pomera napred i ceka nov znak.

Wordovi slabasni pokusaji da vam pritekne
u pomoc

Od Worda mozZete dobiti pomoc¢ na razne nacine, a veéinu ¢u opisati
u poglavlju 2. Za sada moZete videti na ekranu dva mesta s kojih stize
pomoc.

Prvo, tu je polje za pitanja (engl. Ask a question box), koje se nalazi na
desnom Kkraju trake s menijima (slika 1-4). Pritisnite miSem u to polje,

a zatim upiSite pitanje ili klju¢nu rec. Budite koncizni dok piSete; pretva-
rajte se da ste robot. Na primer, umesto da napiSete: ,Reci mi kako da
formatiram ovaj pasus.“, upiSite ,formatiranje pasusa“. Pritisnite taster
Enter i Word ¢e u oknu za poslove prikazati korisne informacije.
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Evo ovde
Slika 1-4: _
Polje za pitanja. = Pocwmesai 3 - Micresall Wand Frasipeie [ @i +REl I-.il
Be EE Bew e Fgrmd  Jem Tgble  Wedom  Help  |Poanein paaput - -i

Ako na ekranu ne vidite pomocnika, izaberite Help => Show the Office
Assistant. U pomoc¢ vam priskace asistent koji izgleda kao animirana spa-
jalica za papir s buljavim o€ima, ali moZete i da ga promenite ako Zelite
(u poglavlju 2 objasni¢u vam kako). Na slici 1-5 vidite pomoc¢nika-spaja-
licu, zvani¢no poznatog kao Clippit.

e

] o

Slika 1-5: T:I

S |
Spajalica.
]

Officeov pomocnik je tu da vam pomogne. Medutim, on uglavnom samo
blene u vas dok piSete ili se dosaduje dok po glavi preturate misli.

Evo nekoliko saveta:

v Pomoc¢nika moZete da pomerate vukuci ga miSem. Ja svog pomoc¢-
nika smestim u donji desni ugao ekrana gde nece zapasti u nevolje.

v Desnim tasterom miSa izaberite Office Assistant da biste videli listu
opcija njegovog menija. Moja omiljena stavka menija je opcija Ani-
mate koja Cini da pomocnik radi nesto zanimljivo.

v MozZete da izaberete jednog od brojnih Officeovih pomocénika: priti-
snite desnim tasterom misSa Office Assistant i iz priru¢nog menija
izaberite stavku Choose Assistant. Moj najdrazi pomoc¢hnik je pas,
mada mi je drag i Merlin.

v Ako prezirete pomocnika, desnim tasterom miSa pritisnite njegov
nos i izaberite opciju Hide. Ekran je ionako pretrpan.

v Pomoc¢nik nestaje s vidika kada se iz Worda prebacite u druge
programe.

v U poglavlju 2 je objasnjeno kako da Officeovog pomocnika koristite
kada vam treba pomo¢.

Pogled na tastaturu

Najkrace rastojanje izmedu vaseg mozga i Wordovog dokumenta, vodi
kroz vaSe ruke i prste do tastature racunara. Tastaturu necete koristiti
samo za pisanje, vec i za uredivanje teksta i zadavanje raznih komandi
koje ga ulepSavaju.
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Poglavlje 1: Pogled izbliza

Na slici 1-6 prikazana je tipicna tastatura za PC koriS¢ena u vremenu
smene vekova (20. i 21. veka, a ne 19. i 20. kada je reC ,tastatura“ ozna-
Cavala klavijaturu).

Esc Funkcijski tasteri Kursorski tasteri

AN
() P N O e R T

ﬁ =
|
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uvene AN N
atrakcije \H Tt
tipicne

tastature za PC. | Nesamostalni tasteri Tasteri pisace masine Nesamostalni tasteri Numericka tastatura

Vidite li kako je tastatura podeljena na razliCite oblasti, od kojih svaka
ima posebnu funkciju? U Wordu koristite sledece tastere, bilo same ili
u kombinaciji s nekim drugim:

v Funkcijski tasteri: smeSteni su uz gornju ivicu tastature i obelezeni
sa F1 do F12. Ovi tasteri koriste se sami ili u zaveri s tasterima Ctrl,
Alt i Shift.

v Tasteri pisace masine: standardni alfanumericki tasteri koje Cete
naci na svakoj pisacoj masini. Od A do Z, od 1 do 0, plus simboli i
drugi egzoticni znaci.

v Kursorski tasteri: tasteri sa strelicama koji pomeraju kursor preko
ekrana. U istom paketu su i tasteri Home, End, PgUp (ili Page Up),
PgDn (ili Page Down), Insert i Delete. Umalo da zaboravim, u kursor-
ske tastere ubrajaju se i veliki taster sa znakom plus i onaj mali sa
znakom minus na numerickoj tastaturi.

v Numericka tastatura: ovi tasteri mogu predstavljati brojeve ili slu-
Ziti za kontrolu kursora (nikako ne mogu da se odluce). Njihovu
podvojenu licnost odaju vec¢ natpisi na tasterima — imaju po dva
simbola. Taster Num Lock i odgovarajuca lampica ukljuceni su kada
je aktivna numericka tastatura (1, 2, 3). Ukoliko su aktivni kursorski
tasteri (strelice, Home), Num Lock je iskljucen.

v/ Nesamostalni tasteri: ne rade niSta samostalno — Shift, Alt i Ctrl
deluju samo u kombinaciji s drugim tasterima.
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20 Deo I: Zdravo svete!

Evo i pojedinacnih tastera koje vredi pomenuti:

v Enter: obeleZen reCju Enter i ponekad zagonetnom savijenom streli-
com [J, ovaj taster se koristi za zavrSavanje pasusa.

v Esc: zapravo, ne radi niSta u Wordu; medutim, ako se nalazite u
okviru za dijalog i pritisnete taster Esc, postici Cete isto kao kad
miSem pritisnete dugme Cancel.

v Razmaknica: jedini taster koji nema oznaku. Sluzi za umetanje raz-
maka izmedu reci.

v Tabulator: umece ,znak“ Tab, koji pogura ono §to otkucate do sle-
deceg polozaja tabulatora. Zanimljiv i donekle frustrirajuci taster za
formatiranje (ali lepo opisan u poglavlju 13).

v Backspace: briSe tekst vracajuci vas za po jedno mesto unazad.
Vrlo korisno.

v Delete: oznacen je i kao Del, a funkcioniSe sli¢no kao i taster Back-
space, samo Sto se ne vraca da izbriSe tragove. Vise o njemu u
poglavlju 4.

Otpustanje tastera

Kada kaZem da otpustite taster Enter, treba da pogledate svoju tastaturu,
pogledom fiksirate taster Enter, i glasno kazete: , Ti, smeSni tasteru. Pot-
puno si bezvredan. Svi drugi tasteri te mrze. Mali prst na mojoj desnoj
ruci te mrzi. Prezren si! Smesta napusti tastaturu i sakrij se, sramoto! Ti,
bezvredni tasteru!“ Tako, sad je taster Enter otpusten.

Zapravo, tastere ne ,otpuState“, vec ih pritiskate i puState. Svaki kratak
udarac po tasteru svrsava posao. Bolje tastature tako lepo klik¢u da
kucanje postaje bucno kao na staroj, mehanickoj pisacoj masini.

Kombinacije tastera

Da biste Wordu saopstili kako da izvrsi pojedine komande, osim obi¢nog
kucanja treba da koristite i razne kombinacije tastera. Na primer:

Ctrl+P

Ili, ukoliko moZzete da uhvatite koSarkasku loptu jednom rukom, poku-
Sajte sa:

Ctrl+Shift+F12

Obe precice otvaraju okvir za dijalog Print — §to u ovom trenutku i nije
mnogo vazno. Ono §to vam ove kombinacije govore jeste da pritisnete

i drZite taster Ctrl dok pritiskate P, a potom pustite oba tastera; ili, priti-
snite i drZite tastere Ctrl i Shift, a zatim pritisnite taster F12; pustite sva
tri tastera.
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Poglavlje 1: Pogled izbliza

S

Uvek pritisnite i drZite prvi taster (ili tastere), a zatim pritisnite poslednji
taster. Pritisnite i pustite.

v Ova metoda funkcionise kao kad pritisnete Shift+F da biste dobili
veliko F. To je isto, ali s Cudnim tasterima Ctrl (Control) i Alt (Alter-
nate).

v Da, zaista treba da se protegnete kako biste otkucali neke od ovih
kombinacija.

v Nema potrebe da jako pritiskate. Ukoliko vam kucanje kombinacija
ne ide lako, to Sto Cete pritisnuti jace nece naterati raCunar da
pomisli: ,,O, BoZe, sad je stvarno pritisnula. Izgleda da misli ozbiljno.
Probudi se, probudi se!“ Lagani dodir je sasvim dovoljan.

v Ne zaboravite da pustite tastere: u kombinaciji tastera Ctrl+P priti-
snite i drZite taster Ctrl, pritisnite P, zatim pustite oba tastera. Ako
ne znate koji prvo da oslobodite, pustite drugi taster, a Shift (Shift,
Ctrl, Alt) na kraju.

v’ Ukoliko ste slucajno otvorili okvir za dijalog Print, pritisnite dugme
Cancel (otkazi) ili Close; ili, pritisnite taster Esc. NeSto viSe o otka-
zivanju Stampanja bic¢e reCeno u poglavlju 9.

Napustanje Worda nakon zavrsenog posla

Znati kada treba otici, osnovno je pravilo lepog ponasSanja. Ja obi¢no napu-
stim Zurku pre nego sto ljudi po¢nu da lome stvari ili spaljuju namesta;j.
Nekada je najbolje i ne pojaviti se. Medutim, Word ne mari za drustvene
norme. Kada zavrSite pisanje, vreme je da napustite Word.

1. Izaberite File => Exit.
Ovo je standardna kombinacija za napuStanje programa koji rade
pod Windowsom.

2. Snimite sve datoteke za koje vas Word pita da li Zelite da ih
saCuvate.

Word vas uvek upozori pre nego Sto ode; ako niste snimili dokument,
Word ce vas pitati da li Zelite da ga saCuvate na disku. Pitanje se pri-
kazuje na ekranu. Officeov pomocnik (ako je vidljiv) objasnjava to
upozorenje u oblacicu, kao na slici 1-7.

Izaberite Yes da biste snimili datoteku. MoZda ce se od vas traZiti i da
datoteci date ime, ako to vec niste uradili. (U poglavlju 2 videcete kako se
to radi.)

Ako to Sto ste napisali nije vredno Cuvanja, izaberite No.

Da biste ponistili komandu Exit, izaberite Cancel, vratite se Wordu i jos
malo se sladite procesom obrade teksta.
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22 Deo I: Zdravo svete!

1
jl *Horaslt Word

[0 ) sk (o e bhes Cchanges o)
s b Couaresnt |7

wes [ Canoss
b
N
I B
Slika 1-7: ';"_'Hj
Av! Av! Av! |! ; !

Ako odlucite da izadete iz Worda, on napusta ekran i pojavljuje se Win-
dowsova radna povrsina, gde mozete da otvorite jos jedan pasijans.

Q&“JH

Q

Nemojte da resetujete racunar ili da ga iskljucujete da biste izasli iz
Worda, jer tako moZete da oStetite datoteke na disku! Racunari su ionako
dovoljno problematic¢ni. Nema razloga da nesmotrenim potezima pove-
cavate opsStu zbrku.

UPQ?

Kako da zatvorite dokument a da ne izadete
iz Worda

Pomoc¢u komande File = Exit, izaci ¢ete iz svih Wordovih dokumenata na
kojima radite. Ako hocete da napustite samo jedan dokument, a da druge
ostavite otvorene, ili ukoliko biste hteli da zatvorite dokument na kome
sada radite i otvorite novi, umesto ove komande koristite File=> Close.

Komanda File = Close zatvara prozor dokumenta, koji tako nestaje sa
ekrana. U prozoru viSe nema , belog prostora“. Ipak, Word je jo§ uvek
aktivan; palete alatki i ostalo joS se vide i nude vam viSe opcija u vezi
sa vasim sledecim potezom.

v Zasto zatvarate dokument? Zato Sto ste ga zavrsili! MoZda hocete da
radite nesto drugo ili da izadete iz Worda nakon zatvaranja doku-
menta. Izbor je vas, a ja ¢u sve opcije objasniti u sledec¢em poglavlju.

v Zatvaranje dokumenta u Wordu sli¢no je kao kad istrgnete papir iz
pisace masine, samo bez onog prijatnog propratnog zvuka.

v Zapravo, nema potrebe da zatvarate dokument. Ja na dokumentu
radim i po nekoliko dana i stalno je otvoren (a moj racunar uklju-
Cen). Nista ne smeta. (Ali obavezno ga snimim na disk.)
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Poglavlje 1: Pogled izbliza 23

v’ Ako pokuSate da zatvorite dokument koji niste snimili, Word prika-
zuje okvir za dijalog sa upozorenjem. Pritisnite dugme Yes da biste
snimili dokument. Ukoliko Zelite da nastavite rad, pritisnite dugme
Cancel i prionite na posao.

v Kad istovremeno radite na nekoliko dokumenata, umesto onog koji
ste upravo zatvorili, pojavice se drugi dokument.

Zapocinjanje novog dokumenta

Jedna od stvari koju moZete uraditi nakon zatvaranja dokumenta, jeste
da zapocnete nov dokument. Da biste to uradili, izaberite File > New

i pojavice se prozor New Document u kome treba da odaberete stavku
Blank Document. Sada ste spremni da pocnete rad na neCemu novom.

v Nov dokument moZete otvoriti i ako pritisnete dugme New Docu-
ment na paleti standardnih alatki.

v lli, moZete otvoriti dokument koji ste ranije snimili na disk. To cete
uraditi pomocu komande File &> Open, s kojom ¢u vas upoznati u
sledecem poglavlju.

v Ako Zelite da pocnete rad na novom dokumentu, ne morate izlaziti
iz Worda.
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